
Avant de commencer

Télécharger Blender via Blender.org 
télécharger la famille de police «Roboto» via «Google Font»

Après avoir installé Blender sur votre ordinateur,créez un nouveau dossier 
«Projet» avec l’arborescence suivante:

Un dossier «Blend» pour acceuillir la sauvegarde du projet.
Un dossier «Font» pour acceuillir les polices d’écritures, 

placez-y le fichier «Roboto-Bold».
Un dossier «Render» pour acceuillir le rendus de l’animation final.

Dans ce tutoriel, nous allons souvent switcher 
entre l’  et l’ .

Pour être plus rapide, appuyez sur TAB.

https://fonts.google.com/specimen/Roboto
http://blender.org/download/


Selectionnez la caméra, affichez la sidebar avec la 

touche  et mettez les mêmes valeurs de 

transformations que sur l’image de droite.
N’hésitez pas à activer les cadenas pour vérrouiller la caméra.  

Gardez la caméra selectionné, dans 
l’éditeur de propriété cherchez une 
icônes verte en forme de caméra.
Celle-ci vous permet d’accéder au 
propriétés de la caméra.
Passez le type en «Orthographic» avec 
une valeur de 7.314.

Depuis l’onglet vertical, cliquez sur 
l’icone grise en forme d’appareil photo 
pour accéder au Render properties.

Passez de Cycle à Eevee.

Eevee est un moteur de rendus en temps 
réel, idéal pour ce projet.

Le fait de cocher «Transparent» permet 
d’activer la transparence si besoin.

Dans Color Management, assurez-vous 
d’être en «Standard» ( pour éviter des 
rendus un peux grissonants ).

2 : Propriétés du rendus

1 : Propriétés de la caméra



Depuis l’onglet vertical, cliquez sur 
l’icone grise en forme d’imprimante 
pour accéder à l’Output properties.

Pour le format de sorties, on va faire 
simple: du 1920px par 1080px.

Laissez le pourcentage à 100% et le 
frame rate à 24 fps.

Pour la durée de l’animation ( le Frame 
Range ), vous allez partir sur une 
durée de 138 images.

Ceux-ci seront rendus dans le dossier 
«Render».

Dans «Output», cliquez sur la petite 
icone en forme de dossier pour spéci-
fier le chemin où écrivez directement un 
lien relatif.

Laissez coché «File Extensions».

Les images finaux seront du PNG en RGBA 
(Red-Green-Blue-Alpha).

Le reflexe qui peux sauver tout type de projets 
c’est bien évidement la sauvegarde.
Le racourci clavier est à utiliser sans modération.

3 : Propriétés de sorties



Commencez par contrôler le Gizmo en allant dans la 
Sidebar ( vue précédement ). 
Accessible via le petit onglet «View».
Mettez la valeur de Location Z à 0.768, 
le reste à 0.

4 : Le gizmo

Pour remettre toutes valeurs à 0, placez la 
souris sur l’une des trois valeurs puis avec un 
clique-droit faites un «Resent All to Défault 
Values».

5 : Le premier plans

Utilisez le menu «Add» pour créez un 
nouvel objet de type Mesh, choisissez 
«Plane».

De gauche à droite, vous pouvez choisir de manipuler les 
vertex, les edges, les faces.

Avec l’outil «Loop Cut», survolez le mesh pour faire apparaître un tracé 
de prévisualisation, une fois que celui-ci se cale sur l’axe X ( rouge ) 
validez avec un clique de souris.
Cliquez sur l’onglet flottant qui vient d’apparaître pour ouvrir les 
options et mettez le «Number of Cuts» à 2.



Passez en mode de selection de face puis en un 
clique selectionnez la face du millieu.
Appuyez sur la touche  ( Mesh > Delette ).

Sur le côté droit de la vue 3D, cliquez 
sur l’icône de la caméra pour travailler 
suivant la vue de la caméra.
Déplacez les vertex en vous référent aux 
indications et à l’illustration 
ci-dessous.

Les vertex placé sur la «zone supérieur» devront 
être placé à 0.83904 de l’axe Y.

Et ceux de la «zone inférieur» devront être placé 
à -0.57594 de l’axe Y.

Gardez votre objet selectionné,
Dans Material Properties, cliquez 
sur «New» pour créez un nouveau ma-
tériau et changez le type de surface 
en «Holdout».

Le Holdout est une surface
qui renvois une transparence total.
( idéal pour cacher des meshs )



6 : Ajout d’un caractère

Créez un Text en utilisant le menu 
«Add» ( comme vus précédement ). 
Pour les paramètres de «Font», 
changez juste le Régular en cliquant 
sur l’icone en forme de dossier.
Parcourez l’arborescence & choisissez 
la typo «Roboto Bold».

Dans la sidebar, mettez 
les mêmes informations 
de transformations.

Sur les informations 
de location, cliquez 
sur les cadenas afin de 
vérouillez l’objet ( 
comme pour la caméra ).

Utilisez votre clavier comme pour un traitement de texte & remplacez ce 
qui est écrit par un «9».

Gardez le texte selectionné,
Dans Material Properties, créez un nouveau 
matériau et changez le type de surface en 
«Emission».

Modifiez la couleur 
à votre guise.
 

Code Hexa pour un blanc 
total: FFFFFF

Code Hexa pour un noir 
absolus: 000000



Depuis la vue de caméra.
Sélectionnez et déplacez les vertex comme sur 
l’image ci-contre.

Sur l’axe Y, positionez les vertex du haut à 
0.83904 & les vertex du bas à -0.57594.

Sur l’axe X, ceux de gauche sont positionné à 
0.4222, ceux de droite à 1.2894.

Faites un «Loop Cut» sur l’axe X, celui-ci sera 
utile dans une autre étape du tutoriel.

7 : Sous le caractère

Créez un nouveau plans, ce dernier sera 
disposé en dessous du texte avec les 
propriétés de transformation suivantes:

Toujours dans un soucis d’anticipation, appuyez sur  pour ouvrir 

le menu contextuel et faites un «Duplicate Objects», puis appuyez sur la 

touche  pour forcer le déplacement de l’objet sur l’axe Z.



8 : Parentage du caractère

Tout en maintenant la touche , sélectionnez - dans l’ordre - le 

texte puis le plans se trouvant juste en dessous, faites un parentage de 

type «Object» en utilisant le racourci clavier ci-dessous. 

Vérifiez que pour les informations de transformations du plans ( Location 
dans la sidebar ) aucun cadenas ne soit activé.
 
Sélectionnez les deux objets et faites une duplication.
N’oubliez pas de forcez le déplacement des deux nouveaux éléments sur 

l’axe .

Sur cet axe, le second plans doit être positionné à -1.8909.

9 : Duplication des éléments



Grace au menu Add ( vus à l’étape 5 ), créez un empty de type sphere.

10 : Ajout d’un empty animé

Positionnez celui-ci entre les deux plans puis comme pour l’étape 8, 
effectuez un parentage des deux plans à l’empty ( selectionnez les plans 
d’abord, l’empty à la fin et faites un parentage de type «object»).

Pour repositionner facilement le curseur 3D, vous pouvez utiliser le menu 
snap ( Mesh > Snap ) mais attention aus fausses manipulations!
Selectionnez un Plans, passez en mode Edit, faites une selection puis 
utilisez le racourci ci-dessous et choisissez «Cursor to Selected».

Sous la vue 3D, changez la «Timeline» en «Dope Sheet».

Pour chaque éditeur son bouton,
ce dernier est rangé au début de chaque 
menu d’éditeurs.

Un clique sur celui-ci permet de passer 
d’un type d’éditeur à un autres.



Dans l’éditeur de propriétés ( Properties Éditor ), renommez l’Empty.

Placez-vous à la frame 44, et - sur les valeurs de Location - ajoutez une 
clé d’animation sur l’axe Y du «Controleur A».

Pour ce faire, placez la souris sur les valeurs et appuyez sur .

La valeur Y doit être à -0.57594 ( il s’agit bien de la Zone inférieur 
spécifié à l’étape 4 ) maintenant marqué par du jaune.

Pour animer le «Controleur A» vous allez utilisez à la fois la vue 3D et 
le Dope Sheet Editor qui vient remplacer la timeline.
La barre bleu vous indiquent sur quel frame vous vous trouvez.
Utilisez la souris ou les touches directionnelless de votre clavier pour 
avancer ou reculer dans le temps.

Pour insérer une seule clé d’animation, 
faites un clique-droit sur une valeur et 
choisissez «Insert Single Keyframe».



Placez-vous à la frame 64, modifiez la valeur de Y à 0.83904 ( il s’agit 
bien de la zone supérieur spécifié à l’étape 5 ) et ajoutez une nouvelle 
clé d’animation.

Dans le Dope Sheet, selectionnez toute les clés avec la touche  .

Appuyez sur la touche  et choissisez «Vector».

Cette manipulation qui peut se faire via le menu du Dope Sheet Editor ( 
Key > Handle Type ) vous permet d’avoir une courbe d’animation droite ( et 
non arrondis ).

Les clés d’animations passent alors d’un aspet arrondis à un aspet carré.

Le Graph Editor vous permet de visualiser les courbes 
d’animation.

Leurs manipulations peuvent ce faire aussi bien sur 
le Graph Editor que sur le Dope Sheet Editor.



11 : Création d’un «Rail»

Reprenez le plans qui est en Stand-By et renomez le en «Rail A».

Sélectionnez «Controleur A» puis «Rail A» et 
faite un parentage ( comme dans l’étape 8 )

Assurez-vous que «Rail A» soit juste en dessous des deux plans.
Selectionnez le loop-cut que vous avez fait à l’étape 5 et remontez les 
deux vertex sur l’axe Y ( vers le millieu, sur une position identique ).

Selectionnez le vertex de gauche, créez un vertex groups nommé «Accroche 
Spacing» et appuyez sur le bouton Assign pour définir le vertex sélectionné 
comme un groupe de vertex.

Dans cette étape, nous allons reprendre le plans qui fait suite à une 
duplication, à la fin de l’étape 7.

Sélectionnez le vertex de droite et ouvrez 
le menu snap ( comme au début de l’étape 
10 ) pour faire un «Cursor to Selected».



Gardez le rail sélectionné & tout en évitant de modifier l’emplacment du 
curseur 3D, allez dans l’option «Set Origin» ( menu Object ) pour faire 
un «Origin to 3D Cursor».

*Cette manipulation vous permet de redéfinir l’origine de votre Mesh.

12 : Plusieurs duplications

Sélectionnez vos éléments ( text, plans, «Controleur A», «Rail A» ) et 
effectuez une duplication - comme à la fin de l’étape 7 - vers la gauche, 
répétez l’opération jusqu’à avoir 7 rangées de caractères.
Renommez les duplicas de «Rail A» et «Controleur A» en respéctant un 
ordre alphabétique de droite à gauche ( «Rail B» et «Controleur B», 
«Rail C» et «Controleur C» etc ).

Pour cette manipulation, «Rail A» doit avoir les 
cadenas activé sur les axes Y et Z, sur les valeurs 
de déplacment ( Location ).



13 : Animations décalé

Sélectionnez tout les empty via 
«Select All by Type».

Dans le Dope Sheet,
fermez tout les onglets bleus clair 
en appuyant sur la petite flèche.
Sélectionnez les clés des «B» 
jusqu’aux «G» et faites un décal-
lage de 5 pixels.

Sélectionnez les clés des «C» 
jusqu’aux «G» et faites de nouveau 
un décallage de 5 pixels.

Refaite l’opération en remontant à 
chaque fois d’un niveau en début de 
sélection.



14 : Système d’espacement

Créez un nouveau Plans ( Add > Mesh > Plane ), nommez Le «Space Ref» et 
placez le hors du champ de vue de la caméra.

Séléctionnez tout puis faites une subdivision à un seul niveau à l’aide 

du menu contextuel que vous appellez en appuyant sur la touche .

Passez en mode de sélection de face et supprimez 3 faces comme illustré 
ci-dessous.
L’origine de l’objet dois se trouver sur ce vertex.

Dans les Vertex Groups, créez un 
nouveau groupe.
Nommez le «Accroche Spacing»,
asssignez-le au vertex de gauche ( 
comme pour l’étape 11 ).

Dans les propriétés d’objet du «Space Ref», 
allez dans le Viewport Display et cochez 
«Name».
Celà vous aidera à identifier rapidement les 
objets dans l’espace 3D. 

Si rien ne s’affichent, vérifiez que «Text info» soit 
coché dans les options de l’Overlay
(menu principal du Viewport ).



Dupliquez «Space Ref» 6 fois et mettez les quelques part en attente.

Maintenant qu’il y’a 
plus rien à faire sur 
«Space Ref»,
vérouillez toutes les 
valeurs de transforma-
tions sauf le Scale sur 
l’axe X.

Renommez les duplicatas de «Space Ref» en «Space A», «Space B», «Space 
C», «Space D», «Space E», «Space F».

Pour chaques objets listé ci-dessous, ajoutez des contraintes.

«Copy Scale» permet de reprendre les informations de mise à 
l’échelle d’un autre objet.
«Copy Location» permet de repositionner l’objet par rapport à un 
autre élément de la scène ( celà peux inclure des vertex groups ).





Pour créez des Collections dans 
une collection, cliquez sur la 
Collection et utilisez ce bouton.

15 : Les collections

Dans l’outliner, créez une nouvelle 
Collection nomé «Spacing Syst».

Puis créez en 7 à l’intérieur de la 
première Collection.

Nommez ces Collections «Letter A», 
«Letter B», «Letter C», «Letter D», 
«Letter E», «Letter F», «Letter G».



Sélectionnez les «Rails» et les «Space» et appuyez sur la touche    
pour déplacez les éléments dans la collection «Spacing Syst».

Les groupes restants doivent être déplacés dans les collections corres-
pondant à leurs emplacements : «Letter A», «Letter B», «Letter C» etc.

Maintenant, vous pouvez :

- Choisir le nombre de caractères à afficher.
- Changer la couleur des caractères.
- Changer l’espacement en effectuant un scale sur 
«Space Ref».

Bref, amusez-vous à modifier le compteur
comme si vous passez un cap important!

https://youtu.be/T6yzNeDthco?si=QMUxwgkDrECopzIi

